INTRODUCTION

The present document introduces the basic concepts of Visual Components’ 3DCreate® software through a series of short exercises that build on top of each other to create a functional robotic workcell.

OBJECTIVE

The objective of the tutorial is to familiarise the user with the basic concepts of 3DCreate®, and the creation of a functional robotic workcell.

STEP 1 - CONVEYOR

This step is to create the conveyor that will be used for material handling during the present tutorial. The conveyor will include interface and behavior.

1.1 Clear the simulation world by pressing ‘New’

1.2 Load Geometry

In the ‘Create’ tab, add a new ‘Geometry’ Feature. Note: Sometimes the simulation world does not allow the creation of a ‘Geometry’ Feature before the creation of a ‘Node’. If this happens, first create a ‘Block’ Feature with the default properties, then add a ‘Geometry’ Feature. After creating the ‘Geometry’ Feature, don’t forget to delete the ‘block’ you have just created.
In the dialog box, select the “Uri” button to choose the geometry.

From the tutorial files, select ‘ConveyorGeometry.3DS’

Press ‘Fill’ from the main toolbar to zoom in on the conveyor geometry

The simulation world should look like the following picture
1.3 Add features

Before defining any new features, the conveyor’s origin needs to be redefined. Select the ‘Measure’ tool from the ‘Tools’ Menu. Click on the outermost vertex from the leg of the conveyor and click again on the origin. The results should be the following.

Measure the distance between the two legs of the conveyor in the same manner to get the following.

We now know the distance between the legs and to the origin. Right-click the ‘Geometry’ Feature and select ‘Translate’.

Fill in the X and Y coordinates with the following information.
Right-click the ‘Geometry’ Feature and select ‘Collapse Feature’ to embed the new coordinates into the geometry. The end results should be as follows.

Now that the conveyor is in place, add three new ‘Frame’ Features. Give intuitive names to the frames.

Translate the three features to the correct height, by translating them to 700 in Z axis.
Translate ‘MiddleFrame’ and ‘EndFrame’ to their corresponding position. The length of the conveyor is 3000. The end results should be as follows.

- **‘MiddleFrame’**
  
<table>
<thead>
<tr>
<th>Translate</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
</tr>
<tr>
<td>1500</td>
</tr>
</tbody>
</table>

- **‘EndFrame’**
  
<table>
<thead>
<tr>
<th>Translate</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
</tr>
<tr>
<td>2000</td>
</tr>
</tbody>
</table>

1.4 Add path

From the Behavior Atoms in the Behavior tab, create a new ‘One-Directional Path’

Change the capacity to 1 and the speed to 200 mm/s
Select the ‘Path’ section and insert the frames in the correct order.

1.5 Add sensor and signal

From the Behavior Atoms, create a new ‘Boolean Signal’

Name the signal as follows:

Create a ‘Component Path Sensor’ to detect incoming components.

Select the frame in which is sensor is to be positioned and the signal which the sensor will trigger.
Open the properties of the One-Directional Path (Double click) and add the ComponentPathSensor to the sensor section of the movement path.

Add another signal for another component to start/stop the movement path. Name the signal ‘StartStop’.

Connect the signal to the movement path.

1.6 Create Interfaces

From the Behavior Atoms, create a ‘One to One Interface’ to define the input of material into the conveyor, and name it ‘Input’.
Select the ‘Sections’ of the interface. Create a new Interface Section and locate the section to the appropriate frame. Since the input will be used to deliver material flow, add a new ‘Flow Field’, and select the input port of the one-directional path.

Add another interface to define the output of material. Name the interface ‘Output’, select the ‘EndFrame’ as its position, add a new Flow Field, and locate it to the Output port of the movement path.

Change the name and save the component. Select the ‘Save Component As’ command from the file menu, and name the component as ‘Conveyor.vcm’ or some representative name. Be sure to save it in a place inside the eCatalogue folders for future access.
**STEP 2 - ROBOT**

This step is to create the robot that will be used in the tutorial.

2.1 **Make sure the robot wizard is installed (if yes, continue with steps. If not, install)**

Go to the Add-ons Menu, and check if the RobotWizard is already installed.

If the RobotWizard is not installed, go to the Downloads section of http://www.visualcomponents.com and download the ‘**SetupRobotWizard_311.exe**’ Add-on. Make sure you have Administrative rights in the computer in use, and follow the instructions for the installation. You have to restart Visual Components’ application for the RobotWizard to be added into the Add-ons Menu.

2.2 **Define the type and size of the robot**

Before starting, make sure the simulation world is free of components.

Go to the Add-ons Menu and select the Robot Wizard.

The following dialog box will appear.
Click ‘Next’ to select the type of robot.

Select the Articulated Robot and click on ‘Next’

Change the size of the robot to reflect the following figure.

Click on ‘Next’ and then on ‘Finish’. The robot will automatically be placed in the simulation world.
2.3 Test the robot using the jog and interact functions

Right-click the robot and select ‘Interact’.

The mouse pointer will change into a hand when it is possible to interact with the links in the component.

A different way of interaction can be achieved by selecting the ‘Jog Joints’, ‘Translate Tool’, and ‘Rotate Tool’ tools from the Teach Tab. Be sure to have selected the robot to enable the tools.

Save the component.
STEP 3 - GRIPPER

This step is to create a simple static gripper.

3.1 Load Geometry

Remember to clear the simulation world before starting any development.

Select ‘Import’ from the File Menu.

Select the ‘Files of type’ to be 3DS files. Select the ‘Gripper.3ds’ file, and click ‘Open’.

When using the ‘Import’ option, a frame and an interface with a hierarchical field are automatically created. The gripper should be in the following position.
Rename the component and save.

3.2 Test

Test if the gripper works well with the robot that was created in the previous step.

**STEP 4 - PEDESTAL**

This step is to define the pedestal in which the robot will be placed. Remember to clear the simulation world.

4.1 Create Geometry

Create a new ‘Block’ Feature. The following dialog box will appear.
Click ‘Ok’ to continue with the Block dialog box. Change the size to reflect the following changes.

Create a new link where the robot is going to be placed.

Leave the default properties for the link.

4.2 Add frame

Add a frame to the new created link to be used by the interface.

Define the new position of the interface by translating it. Use the ‘Snap’ tools to position the frame to the centre of the topmost face.
4.3 Define interface

Create a one-to-one interface to the new link.

Create a new section and a hierarchical field. Select the appropriate node and the frame.

Rename the component and save it.
4.4 Test

Load the robot and test it with the pedestal.

**STEP 5 - PRODUCT AND PALLET**

Remember to clear the simulation world before developing a new component.

5.1 Define Geometry for product

Create a new ‘Block’ Feature with the following measurements.

Assign materials to the product. Choose any material that suits your like.
Rename and save the component.

**NOTE!** Install the `RobotWorkCellComponents.vcp` file, which includes the pallet component, as well as the generic feeder and container filler.

### 5.2 Define Pallet

The pallet used for this tutorial will be the one provided in the component package – ‘pallet.vcm’
STEP 6 - CREATOR

Remember to clear the simulation world before developing a new component.

6.1 Load the generic feeder

From the tutorial component package, load the generic feeder ‘GenerciFeeder.vcm’

From the parameter tab, select the ‘Component Creator’ parameter.

Select the part option, and select the pallet provided in the component package.
6.2 Load Container Filler

Load the ‘Container Filler’ component provided in the package, and PnP to the ‘Generic Feeder’.

From the parameter tab, select the ‘ContainerFiller’ option.

Select the ‘Part’ option, and choose the product you have created in the previous step.

6.3 Test with conveyor

Load the conveyor you created in the first step, and PnP to the Component Filler and test the simulation.

Remember to save the components.
STEP 7 - CREATE A SIMPLE LAYOUT

This step is to test the components together and create a simple layout.

7.1 Load components

Load the component created during the tutorial, and snap them together to form the following layout. Load the generic feeder first, and translate it to the origin by resetting the axes.

Copy the generic feeder by right-clicking on the component, and then paste the copy into the simulation environment.
Translate the copy to the following coordinates.

The end results should look as follows.

Load the Container Filler component and attach it to the original generic feeder. Load two conveyors, and attach them to the feeders already in the 3DWorld.

The layout should be as follows:
Load the pedestal and translate it to the following coordinates.

<table>
<thead>
<tr>
<th>Translate</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1000</td>
<td>1100</td>
<td>0</td>
</tr>
</tbody>
</table>

Load the robot and the gripper to finalize the layout.
7.2 Create a simple program

Select the Robot, and then select the Connection Editor from the PnP dynamic toolbar.

![Connection Editor](image)

The Connection Editor appears as follows:

![Connection Editor](image)

Sort the connections by ID, so that IN and OUT would be next to each other, and search for 51 and 52.

![Connection Editor](image)

**NOTE!** ID 1-50 are used internally by the software, so don’t change any input or output connection in that range.

**TIP!** It is possible to select the component from the 3DWorld simply by just clicking it.

Select IN 51, and connect it to the Conveyor component and the SensorSignal, and the OUT 51 to the StartStop from the same conveyor. Do the same steps for the Conveyor #2 with the IN 52 and OUT 52.
Now that the signals have been connected, the robot can be programmed. In the ‘Teach’ tab, the RSL program can be created. Create a new sequence and name it ‘WaitAndStop’.

Add a new ‘Wait for Binary Input’ and make changes as follows.

Double-click the wait statement and toggle the trigger.

Add another wait sequence for Input 52.
And set Output 51 and 52 to False.

Add a call in ‘Main’ for ‘WaitAndStop’ and test by pressing ‘Run’ on the simulation controls.

For the robot to run a pick-and-place sequence properly, the tool needs to be defined. Select ‘ToolData[1]’ and translate it to reflect the tip of the gripper.

**NOTE!** If the distances are not zero, make sure the coordinates are relative to the parent.

Add a ‘Change of Tool’ statement to the RSL program, and modify it to reflect the changes in the tool point location.
Add a ‘Halt the simulation’ statement. This is for easiness of programming.

Run the simulation. In the end, it should look like the following.

Create a new sequence called ‘PickPlace’.

Select Base_Data[1] and Tool_Data[1].
Use Trn and Rot Tool to move the robot. First snap the robot with ‘Trn Tool’ to the centre of the face of the product, then ‘Rot Tool’ to rotate it for proper alignment. If it makes it easier, toggle the translational and rotational grid and define the steps.

Add a linear motion statement to define the picking point.
Translate in Z Axis 50 mm, to define the point of approach.

Click and hold the second motion statement (point of approach) and drag it to the beginning of the sequence.

Add another point vertical to the point of approach.
Add a ‘Set Binary Output’ and move it as shown in the figure.

Add another point close to the ‘Home’ position of the robot, and move it at the beginning of the sequence.

Add a call to the ‘PickPlace’ sequence from the ‘Main’.

Add similar statement for the placing of the product. Set the Binary Output 1 to False to release the product.

Select ‘PickPlace’ sequence, and add a new point similar to the following figure by using the ‘Jog joints’ function.
Using the ‘Trn’ and ‘Rot’ tools, position the robot so that it is placing the product on the other pallet, as shown in the following figure.

![Robot Workcell](image)

Add another linear motion statement. Set the Binary Output 1 to False to release the product, and add another motion statement with a point of approach, so that the robot seems to retreat from the product.

Once the sequence is complete, go to the main sequence and set the S1 and S2 signals to True to start conveyors. Delete the ‘Halt’ statement.

In the Robot’s parameters, in the ‘executor’ tab, toggle the looping parameter.

Run the simulation.

Save the layout with the ‘Save As’ command in the File menu, and fill in the description page.